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We study the polar collective dynamics of Janus colloidal particles fueled by an AC electric
field. When the density is high enough, the polar interactions between the particles induce a polar
orientationally ordered state which exhibits features reminiscent of the Vicsek model such as true
long-range order and giant number fluctuations. Independent measurements of the polarity and
velocity at the single particle level allowed us to investigate the single particle dynamics within the
ordered state. We discovered theoretically-unaddressed statistical properties of the ordered state
such as the asymmetric relation of polarity and velocity, enhanced rotational diffusion stronger than
in the disordered state, and an algebraic auto-correlation of the polarity. Our experimental findings,
at the crossroad of the Vicsek physics and the Active Brownian Particles physics, sheds light on the
so-far-unexplored physics arising from the interplay between the polarity and the velocity.

I. INTRODUCTION

Active matter systems consume and dissipate energy
at the level of its local units to generate systematic mo-
tion based on their internal degrees of freedom (e.g. po-
larities) [IH4]. After decades of extensive research, it is
now known that active matter systems can exhibit a wide
range of phenomena such as phase separation [5HS], ac-
tive chain formation [9] [10], active turbulence [IIHIZ],
etc. Among these topics, orientational order in active
matter has gained considerable attention since the intro-
duction of the Vicsek model in 1995, where pointwise
polar particles move at constant speed toward their po-
larity and try to align their polarities with local neigh-
bors under the presence of noise [I5]. Theoretical work
concerning the Vicsek-style models has been done in-
cluding particle, kinetic and hydrodynamic levels [16-
[24]. In particular, the phenomenological hydrodynamic
equations by Toner, Tu, Ramawsamy and their coworkers
have predicted the existence of true long-range order and
giant number fluctuations (GNF) for the orientationally
ordered state [T6HIS| 23] 25]. In these theoretical and
numerical studies, each particle’s polarity is assumed to
be parallel to its velocity. In experimental systems, on
the other hand, particles do not necessarily move toward
their polarities due to thermal and /or athermal noise and
inter-particle (hydrodynamic, excluded volume, or elec-
trostatic) interactions (e.g. systems of elongated bacteria
[26], vibrated polar disks [27], motility assay [28], and ac-
tive rolling colloids [29] B30]).
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FIG. 1. Schematic image of the experimental system. (a)
A silica based Janus particle with a metallic titanium hemi-
sphere. (b) The suspension of Janus particles were sand-
wiched by two ITO coated electrodes. The particles sediment
to the surface of the ITO electrode which leads to quasi-two-
dimensional motion on the zy-plane.

Active Brownian Particle systems are suited for in-
vestigating such active systems where particle velocities
do not necessarily coincide with their polarities. Active
Brownian Particle systems have been experimentally re-
alized and studied by using e.g. auto-catalytic colloidal
particles in hydrogen peroxide and rolling colloids un-
der a DC electric field. However, active particles fueled
by chemicals do not exhibit ordered states reminiscent
of those in Vicsek-style models so far [6, [7, [3I]. In the
case of rolling colloids, because the particles do not pos-
sess intrinsic polarity and that their polarities are only
electronic and invisible, in-depth study of the interplay
between the polarity and velocity in the ordered state
is not possible [30]. Thus, our understanding of how
polarity and velocity interact with each other and how
they behave in orientationally long-range ordered col-
loidal systems with hydrodynamic interactions remains
elusive. For example, in the systems of elongated bac-
teria and motility assay, although true long-range order
has been observed, particles could only be detected in a
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coarse grained manner [26], [28].

Janus particles [32], which are colloidal particles with
two distinct hemispheres, offer a great platform for in-
vestigating active matter experimentally [6] 8, @ B3-
37. Among these Janus particles, the ones fueled by
an AC electric field are especially suitable for analysis
from the view point of statistical physics because they
constantly convert energy into motion without running
out of energy sources and thus, allow long enough mea-
surements for statistical analysis [, @, [34] [36H38], which
is not the case for auto-catalytic particles due to the con-
sumption of chemical fuels. Under an AC electric field,
Janus particles display two different mechanisms of swim-
ming depending on the field frequency: induced charge
electrophoresis (ICEP) at low frequency [39-41]; self-
dielectrophoresis (sDEP) at high frequency [42] [43]. Im-
portantly, the two swimming mechanisms induce motion
from the dielectric hemisphere to the metallic hemisphere
I8, @1 [34], 35| 37, B8], 4] or vice versa [9] [35] B8], [43], which
allows us to define and observe each particle’s polarity
based on the location of its metallic hemisphere [8, 9].
Not only the swimming mechanisms but also the interac-
tions between particles depend on the field frequency and
ion concentration, which lead to various types of collec-
tive behavior such as a turbulent phase [34], a swarming
state with vortices [35], flagella-like movement [9] and ac-
tive clustering [8]. Thus, Janus particles provide us an
ideal venue for experimentally studying the collective dy-
namics of ordered systems while keeping track of polarity
at the single particle level.

Here in this paper, we perform experiments on the
quasi-two dimensional system of active Janus particles
fueled by an AC electric field. We specifically use the
AC field frequency regime where Janus particles swim by
sDEP and exhibit a flocking phase. Through the extrac-
tion of both the polarity and velocity for each particle,
we show that this flocking phase of Janus particles can
exhibit true long-range orientational order. This ordered
state of Janus particles also exhibited statistical features
such as GNF and algebraic correlations for orientation
fluctuations which are reminiscent of the predictions of
Toner and Tu. We further investigate the space-time cor-
relations of density fluctuations leading to an estimate
of dynamical and anisotropy exponents for the ordered
state of Janus particles. In addition, through single par-
ticle measurements, we show that the particles counter-
intuitively exhibit larger diffusion in the ordered state
than that in the disordered state for short time scales.
We suggest that this anomalous enhanced diffusion stems
from the coupling between particle polarity and velocity
through computations of the cross-correlation function,
which is a dismissed feature in Vicsek-style models. Our
work, through the observation of both velocities and po-
larities, unravels hitherto unexplored statistical proper-
ties within orientationally ordered active colloidal sys-
tems.

II. EXPERIMENTAL SYSTEM

Our experimental system is composed of silica based
Janus particles with 3.17 pm diameter [9]. To create dis-
tinct hemispheres, 35 nm of titanium followed by 15 nm
of silica were deposited to a monolayer of silica colloidal
particles (Bangs Laboratories, Inc., SSO5N) using elec-
tron beam deposition and thermal evaporation, respec-
tively. After deposition, the particles were suspended
into deionized water and washed by sonication to pre-
vent particles from forming clusters. This washing pro-
cedure was repeated three times after waiting for 30 — 60
minutes for particle sedimentation. The washed Janus
particles were suspended in deionized water and then
sandwiched by two 25-nm-silica-deposited indium tin ox-
ide (ITO) coated electrodes (Mitsuru Optical Co. Ltd.),
separated by 130 um thick double sided tape. Before ap-
plying the AC electric field, we waited for a few minutes
to ensure that the particles have sedimented to the sur-
face of the bottom electrode, which leads to a quasi-two
dimensional system of Janus particles (Fig. . Accord-
ingly, the induced-charge electro-osmotic flow caused by
the electric field lets the particle’s polarity turn to the
horizontal zy-plane, leading to confined motion in the
horizontal 2D-plane [45]. A sinusoidal AC electric field
with f = 1 MHz frequency and 16 V, voltage was ap-
plied for all experiments, where V,;, denotes the peak-to-
peak voltage. In this frequency regime, it is known that
Janus particles tend to move toward its metallic hemi-
sphere, which contradicts with the ICEP theory [39H41].
This was first observed in [38], and is now understood
as sDEP [42, 43]. Experiments were performed under
two different density conditions: the low density regime
where p ~ .78 particles/1000 um?, and the high density
regime where p ~ 13 particles/1000 pum?.

The observations of Janus particles were done using an
inverted microscope (Nikon ECLIPSE TE2000-U) with
objective lens ((Nikon Plan Fluor ELWD, 20x, NA=0.45
or 40x, NA=0.60). A halogen lamp was used to illumi-
nate the particles and a green filter was inserted in the
light path before the sample to increase the contrast of
the obtained images. Under this condition, the polarity
of each Janus particle can be distinguished using with its
dark-gray hemisphere indicating the titanium side, and
the light-gray hemisphere indicating the silica-only side
(for example see Fig. [3(a), Supplemental Movie 2, 3).
The dynamics were recorded at 15 fps and 10 fps for the
40x and 20x view, respectively, using a CMOS camera
(Baumer LXG80, 3000 x 2400 pixels ~ 430pm x 340pum
(40x)). This allowed us to capture the large scale statis-
tics of the particles while detecting the polarities and
velocities of each particle at the same time.

Image analysis was performed using Trackpy [46] and
ImageJ [47]. Specifically, the polarities of the particles
were detected by taking the difference of the centroid and
center of mass of image intensity for each particle using
the built-in algorithms in ImageJ [44]. The duration of
the analyzed movies were 360 s and 212 s for the low and



FIG. 2. Dynamics of Janus particles in the disordered and ordered state. (a), (b) Trajectories of the particles in the disordered
state (three seconds) and the ordered state (two seconds), respectively. (c), (d) Velocity distribution of the particles in the
disordered (9909 particles) and ordered state (40205 particles), respectively [44]. The mean speeds for the disordered and
ordered state were Uy = 14.6 pum/s and 9, = 8.5 pm/s, respectively. (e) Binarized experimental snapshot of the Janus particles
in the ordered state. Each particle is colored based on the deviation of its polarity from the global order |6 — (0)| (radian).

The black arrow shows the direction of global order (6).

high density regime, respectively.

III. RESULTS
A. Binary polar interaction and following motion

To probe the interaction of the Janus particles in our
system, we first measured the relative polarity distribu-
tion P (Af) for all Janus particle pairs in the low density
regime (Fig. 2(a)). To examine the local interactions of
the particles, particle pairs within 6 um and 30 um dis-
tance were extracted, respectively, and the relative po-
larity angle Af was measured for each pair (Fig. b))
[44). The results show that particles within 6 um range
had a narrower distribution with a peak near Af = 0,
which suggests the existence of polar interaction within
the Janus particles. Indeed, when observing two Janus
particles within a short distance, following motion where

one particle tends to follow the other particle could often
be observed (for example, see Fig. [3](c)).

The observed polar interaction and following motion
can be understood as a result of the balance of electro-
static and hydrodynamic interactions between the parti-
cles. Although the interaction mechanism of Janus par-
ticles under an AC electric field is still under discussion
[9, 35], our previous study experimentally validated the
existence of polar interaction induced by the effective
electrostatic dipole-dipole interaction between two par-
ticles both in the ICEP and the sDEP regimes [9]. Note
that, although our study in the sDEP regime uses a simi-
lar AC field frequency as in [9], the smaller ion concentra-
tion in this experiment than in our previous study gener-
ates a longer screening length (Debye length) Ap o< 1/4/c,
where ¢ is the ion concentration [9]. The slip velocity us
generated in the electric double layer scales as us o< Ap,
following from the Helmholtz-Smoluchowski formula [39].
This results in a weak but relatively stronger pusher-type
flow-field than in our previous study [9] which prevents
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FIG. 3. Statistics of binary interactions of Janus particles.
(a) Schematic picture describing the relative angle of particle
pairs. (b) The relative polarity angle A distribution of Janus
particles in a low density situation. R denotes the distance of
two isolated Janus particles. (b) Typical trajectories of two
Janus particles when they are in close distance.
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FIG. 4. The polar order parameter for the ordered and dis-
ordered states. (a) Log-log plot of the polar order parameter
C vs S, the area of the ROI. The blue and red points show
the order parameter for the ordered and disordered state, re-
spectively. (b) The same data as in (a) for the ordered state
in a magnified range (log-log). Inset: the same data as in (b)
with the asymptotic value Coo = 0.726 subtracted (log-log).
The solid black line shows the nonlinear fit: C' = Coo +kS ™"
with Css = 0.726, £ = 0.470, and 2y = 0.177. The data for
ROIs with S > 1.8 x 10* um? have been excluded from the
nonlinear fitting due to the existence of counterflows in the
system.

the particles from forming active chains in the current
setup. It should also be noted that flow fields calculated
based on pusher-type flow fields also show following mo-
tion due to the reorientation of the following particle,
which is consistent with our observations [48, [49]. This
synergy of electrostatic and hydrodynamic interactions
leads to polar alignment, allowing us to observe the or-
dered dynamics of Janus particles as we see below.

B. True long-range order

Janus particles exhibited distinct global patterns when
we changed particle density. While Janus particles ex-
hibited uncorrelated disordered motion in the low den-
sity regime (Fig. [2(a), (c), Supplemental Movie 1),
orientationally-ordered coherent motion was observed in
the high density regime (Fig. (b), (d), (e), Supplemen-
tal Movie 3, 4) due to the local polar interaction. This
density dependency of Janus particles is consistent with
the previous experimental results of [35]. To quantita-
tively assess the properties of orientational order in the
low and high density regimes of the system, we computed
the polar order parameter,

C = ([{e”)s])e, (1)

for different sizes of rectangular (5:4) regions of interest
(ROIs), where 0 is the particle polarity and (-)g and (-);
denotes the average within the same ROI and statisti-
cally independent time frames, respectively (Fig. [4] [44]).
Here, the ROIs with different area size S were placed at
the center of the whole field of view. In the low density
regime, the polar order parameter decays as a power law
C  1/v/'S (Fig. a)). This is consistent with the case
with N randomly oriented particles. In contrast, in the
high density regime, we can observe a decay slower than
a power law within S ~ 10* pm?. This asymptotic be-
havior characterizes the true long-range order, which was
previously reported in Vicsek-style models [4] and in the
bacterial experiment [26] where the orientational order
parameter converges to a finite value. To confirm the ex-
istence of true long-range order, we performed nonlinear
fitting for the polar order parameter at S < 1.8x10% pm?,
using the curve_fit function from the scipy package [50].
The data was in good fit with an algebraic convergence
to a finite value C' — Cs ~ S™27 where Co = 0.726 and
2y = 0.177 (see the inset of Fig. [{b)), which indicates
true long-range order in the system. It should be noted
that previous simulations showed v = 0.64 for the Vicsek
model [4]. At the same time, however, the decay of the
order parameter deviates from this trend of algebraic con-
vergence at S > 1.8 x 10* um. This is caused by the exis-
tence of counter-flows of the particles (see supplemental
movie 3, 4) which is unavoidable due to the closed bound-
ary conditions and the number conservation of the par-
ticles unless we elaborate an effective periodic boundary
condition by e.g. a racetrack-like confinement [29]. How-
ever, in the case of our electrically driven Janus particles,
micro-structures fabricated by e.g. photoresist distort
the electric field, which leads to unwanted complex 3D
electroconvection and destroys the two-dimensionality of
the system. Therefore, we opted for using a simple sys-
tem by sandwiching as large a droplet of the suspension
of Janus particles as possible between the two electrodes.
Overall, the finite size scaling analysis assures that the
Janus particles exhibit polar collective motion with true
long-range order.
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FIG. 5. Auto-correlation functions. (a) Polarity auto-correlation function in the ordered and disordered state (semi-log). T

denotes the time delay. (b) The same data as in (a) in a magnified view which is shown as a gray box in (a) (semi-log). The
dashed line shows exp (—2D,7) where D, ~ 1/24.2 s™" is the rotational diffusion constant for a 3.17 um diameter particle
derived from the Einstein-Stokes relation. Error bars show the standard error. (c) The connected auto-correlation functions
for polarity: fp,c(7) and velocity: fu,c(7) in the ordered state. The blue dashed line with a slope: —0.7 is a guide for the eye.

C. Interplay of polarity and velocity

To investigate the detailed dynamics of single particle
trajectories, we computed the polarity auto-correlation
function f,(7) for the disordered and ordered states, re-
spectively. Here,

fo(r) = (np(t) - mp(t + 7)1, (2)

where n,,(t) denotes the polarity for the particle at time ¢,
and (-); takes the average for particle trajectories longer
than 24 seconds (Fig. [p[a)(b)). We can first observe
that the polarity auto-correlation decays exponentially
in the disordered state. At small time scales, this de-
cay was slightly faster than the theoretical estimation for
an active Brownian particle f,(1) = exp(—2D,7) [33],
where 1/D,. ~ 24.2 s is the rotational diffusion constant
(Fig. [fla)) from the Einstein-Stokes relation, which is
due to the polarity detection errors [37]. We thus focus
on the time scale 7 = 0-12 s, where the decay of the
auto-correlation exhibited a slope of 21.15 4 0.08 s, close
to that of the theoretical estimation.

In the ordered state, on the other hand, f,(7) exhib-
ited a slow power-law like decay in the long time scale
(t > 1s, Fig. . Since particle polarities in the ordered
state tend to align to the global order, we suspected that
this power-law behavior of f,(7) is related to the fluctu-
ations of the global order. To assess this hypothesis, we
compared the connected polarity auto-correlation func-
tion in the ordered state with that of the global order
(Fig. [6). In Fig. [5fc), we show the connected polarity
(velocity) auto-correlations,

fo.o(7) = (Any(t) - Any(t + 7))t 3)

fo.o(T) = (Any (1) - Any(t + 7)1, (4)

where An,, ,(t) = 1y o () — (np (1)), and (ny, ,(t)) is the
direction of global order defined by polarity or velocity,
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FIG. 6. Fluctuations of the mean polarity in the ordered
region. (a) Time series of the fluctuations of global order (0§ —
(0))ordered Where (-)orderea takes the average within the highly
ordered region (S < 1.8x10* um). (b) Auto-correlation of the
polarity fluctuations from global order fgiobal,c(7) = (Anp(t)-
A'hp (t + T)), where Aﬁp (t) = <np - <np>t,ordered>ordered~ The
blue dashed line with a slope: -0.85 is a guide for the eye.

respectively. A power-law like decay with a slope close
to —0.7 for f, ¢(7) could be observed for both the polar-
ity and velocity auto-correlations. Interestingly, the con-
nected auto-correlation of the global order fgiobal,c(T)
[44] also showed a power-law like decay with a slope
close to that of f,c(7) (Fig. @(b)) This supports our
hypothesis that the power-law behavior of the polarity
auto-correlations is a consequence of the fluctuations in
global order. However, it should be noted that in a fi-
nite system, the direction of global order diffuses such
that the auto-correlation function decays exponentially
[24]. Therefore, we should expect that the power-law be-
havior of fglobal,c(7) that we observe is a transient to
an exponential decay. Indeed, when we focus on longer
time scales (7 > 10 s), we can observe a decay faster
than a power-law for fgiopal,c(7) (Fig. . Although the
limited length scale of our experimental system hinders
the long time behavior of single particle trajectories, we
expect that the connected polarity auto-correlation func-



tion f, o(7) will also show a crossover to an exponential
decay, reflecting the fluctuations of the global order.

The polarity auto-correlation function for particles in
the ordered state also exhibited peculiar behavior at
short time scales (7 ~ 1 s). Fig. [f[b) shows a magni-
fied view of the behavior of f,(7), and it can be observed
that f,(7) of the ordered state decays faster than that
of the disordered state at short time scales. Because this
time scale is similar to the time scale of the mean free
time (distance to the nearest neighbor ~ 7 um)/(average
velocity 7,) ~ 0.8 s, we speculated that this enhanced
diffusion was caused by the frequent and continuous in-
teractions among closely distanced particles in the or-
dered state. To confirm this speculation, we computed
the polarity-velocity cross-correlation function,

gpv(T) = <np(t) : nv(t + 7_)>ta (5)

where n,(t) = v(t)/|v(t)| is the unit velocity vector at
time ¢ (Fig. [7). The assessment of g, (7) revealed the
asymmetric relation of polarity and normalized velocity
in the ordered state, where polarity tended to correlate
the most with the velocity of 7 ~ 0.2 s in the past. In
other words, the polarity in the ordered state tended to
follow the direction of the velocity of the particle with
a finite time delay. It should be noted that, although
not statistically significant, g,,(7) in the disordered state
showed a weak, if any, asymmetry around 7 = 0 as well.
These results imply that the asymmetry in gy, (7) is am-
plified in higher density situations. We therefore suspect
that this asymmetry is caused by electrostatic and/or
hydrodynamic torques induced by collisions between in-
dividual particles. Overall, our results suggest that the
particle polarities tend to follow the particle’s velocity,
yet local interactions between nearby particles disturb
their alignment causing a time delay especially at the
high density state. These effects might explain the en-
hanced diffusion observed in the ordered state.
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FIG. 7.  Polarity-velocity cross-correlation functions. (a)

The cross-correlation function gp»(7) for Janus particles in
the ordered (blue) and disordered state (red). (b) The same
data as in (a) in a magnified view for the gray box shown in
(a). Error bars: standard error. The difference in error bar
size is caused by the sparsity in the disordered state.
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FIG. 8. Scaling of number fluctuations. (a) Number fluctu-

ations in the ordered (blue) and disordered (red) state. (b)
Same data as in (a) with the number fluctuations normal-
ized by (N)®®. The cyan and magenta dashed lines show
AN o (N)*® and AN o (N)°5, respectively, as a guide to
the eye. The gray dashed line indicates the scale of counter-
flows up to which the true long-range order persists.

D. Giant number fluctuations in the ordered state

Giant number fluctuations (GNF), where the variance
of the number of particles AN? grows faster than its
mean (N) (AN? o (N)2* with 2o > 1) in long-range
ordered phases, are a hallmark of the Toner-Tu phase
[16, 17, [23]. Since its theoretical prediction by Toner, Tu,
Ramaswamy and their coworkers [16] 17, 25], the pres-
ence of GNF has been extensively studied in numerical
systems [I8, 2], 24, [5I]. However, in addition to experi-
mental difficulty in realizing collective motion with true
long-range order, experimental detection of GNF requires
delicate treatment due to many possible pitfalls such as
difficulty in disentangling fluctuations arising from e.g.
phase coexistence or boundary effects as critically dis-
cussed in [26]. Therefore, GNF as the hallmark of the
Toner-Tu-Ramaswamy phase had remained undetected
until recent experiments on a long-range ordered nematic
phase of elongated bacteria [26] and then on the polar or-
dered phase of colloidal rollers [30]. Here in our Janus
particles system, as we have confirmed the true long-
range order, it is natural to question whether the ordered
state shows anomalous number fluctuations.

To quantify number fluctuations, the mean (N) and
standard deviations AN of the number of particles for
different sizes of ROIs were calculated for statistically
independent frames (Fig. [§). For the disordered state,
normal number fluctuations with AN oc (N)%® were ob-
served, which is consistent with the central limit theo-
rem. In contrast, anomalous number fluctuations were
observed in the ordered state where AN o (N)® with
a > 0.5. In fact, the estimated exponent was a =
0.790(5) with 95% confidence level, which is very close to
the theoretical prediction o = 0.80 |16} [I7] and the recent
numerical estimate o = 0.84 for the Vicsek model [24].
It is worth noting that the existence of non-trivial GNF
has to be discussed under the presence of true long-range
orientational order. Indeed, there are several experimen-
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ordered state. (a) Color map of the correlation function
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of Cc (R) both in the transverse (R, purple) and longitu-
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tal studies that report GNF for systems that are not in
the fully ordered state (for details see the supplemen-
tary material of [26]). Here, we have set all ROIs to be
placed at the center of the whole image so that the ROIs
correspond to those that were used for the computation
of the order parameter. Accordingly, the gray dashed
line in Fig. |8 indicates the length scale S ~ 10* um? at
which the order parameter in the ordered phase starts
to deviate from algebraic convergence to a finite value
(i.e. true long-range order). Therefore, the observation
of anomalous fluctuations below this line imply that or-
dered Janus particles do exhibit GNF in the context of
the Toner-Tu phase. Number fluctuations in the ordered
state exhibited a slope close to 0.8 even at scales larger
than S > 10* pm?, where the orientational order is dis-
turbed by counterflows. This might explain why GNF
could be reported in a wide variety of experimental sys-
tems without a fully ordered state.

E. Algebraic scars of long-range order

When a continuous symmetry is spontaneously broken,
the entire ordered phase should also be characterized by
an algebraic decay of its connected correlation functions
[52]. In the case of the Vicsek model, a power-law decay
for the orientation fluctuation correlation function exem-
plifies the spontaneous symmetry breaking of the rota-
tional symmetry of the system, and its exponents have
been predicted by the hydrodynamic theory of Toner and
Tu [16] 177, 23]. Interestingly, a recent numerical study of
the Vicsek model suggested that the ordered state could
exhibit GNF exponents close to the conjectured values
even though there existed a discrepancy in the expo-
nents of the correlation functions [24]. Thus, in addi-
tion to number fluctuations, the fluctuation correlation
functions are important measures to probe the statistical
properties of orientational order in the system.

To address the questions of whether the orientational
fluctuations of Janus particles exhibit scale-free correla-
tions, and if so, whether they follow exponents of the
Toner-Tu conjecture, we measured the orientation fluc-
tuation correlation function,

Co(R) = ({0np 1 (t,7)onp (87 + R))r)e, (6)

where dny ) (t,7) = np(t,7) — (np) is the deviation of a
single particle polarity m, from the global order (np),
and (-), takes an average for all |R| distanced particle
pairs (see Fig. E[) Here, the global order (n,) was cal-
culated by averaging the polarity n, both spatially and
temporally. Figure [0[b) shows the decay of Cc(R) in
the transverse and longitudinal directions to global or-
der. Although there is an anisotropy in the absolute
value of the correlation function, it decays algebraically
in both directions with the same exponent close to —0.52.
This algebraic decay signifies the spontaneous symmetry
breaking of the rotational symmetry of the system and
consequent scale-free features. However, the exponents
of the decay differ from the Toner-Tu conjecture which
predicts an anisotropic decay of Ce(R) o RI_2/5, Rﬁ/g.
This discrepancy might stem from the difference in mi-
croscopic properties including steric and hydrodynamic
interactions as we will discuss in the following section.
Interestingly, recent experimental [30] and numerical [24]
studies for polar orientational order have both reported
weak, possibly vanishing, anisotropy for the orientational
fluctuation correlation function. In addition, analysis on
the space-time correlations of density fluctuations also
suggest weakly anisotropic sound modes propagating in
the colloidal flocks (Fig.[S2)). This leads to the estimate
of the dynamical exponent z ~ 1.2 while the anisotropy
exponent & ~ 1, suggesting a non-diffusive but weakly
anisotropic dependence that qualitatively agrees with re-
cent numerical simulations [24]. Our measurements of
Cc(R) and the sound modes, along with previous stud-
ies [24], may suggest a correction for the renormalization
group analysis on collective motion.

IV. DISCUSSION

We studied the collective motion of active Janus par-
ticles fueled by an AC electric field. At high density,
the Janus particles exhibited polar orientational order
which allowed us to investigate and compare the statis-
tical properties of the system with that of the Toner-Tu
phase. We have confirmed GNF within the polar orien-
tational ordered state with an exponent similar to but
different from the theoretical predictions of Toner and
Tu. In addition, an algebraic decay was observed for
the orientation fluctuation correlation function which is
also associated with the spontaneous symmetry break-
ing of the rotational symmetry of the system. The ob-
served exponents showed a discrepancy with the theoret-
ical predictions and recent numerical simulations [24] of



the Vicsek model, suggesting a different mechanism for
the emergence of long-range order. As pointed out in [26]
and then both experimentally and numerically verified in
[28] 53], weak volume exclusion that allows crossing over
other particles is considered a key to make collective mo-
tion of elongated objects similar to the Vicsek-style in-
teractions and thus achieve long-range order at least for
the otherwise turbulent or clustering 2D nematic systems
such as bacteria and gliding microtubules [26 2§]. In the
case of polar collective motion, the weak exclusion may
not be a requirement for the long-range order because the
particles cannot overlap each other in our experimental
setup as in granular experiments [27, [54]. What realizes
long-range order in polar systems could be the following
motion exemplified in Fig. |3 as discussed previously in
e.g. mutant Dictyostelium cells [55], and/or the torque
aligning the polarity to the velocity, as studied in vi-
brated polar disks [56].

Our results might suggest that, although GNF could
be observed, algebraic decay as in the Toner-Tu phases
are difficult to observe in experimental systems as well
as in numerical simulations. The exponents of the al-
gebraic decay for the orientation fluctuation correlation
function differed from that observed for polar flocks of
Quincke colloidal rollers [30]. Although Janus parti-
cles and Quincke rollers are both considered as polar
particles with polar interaction, the polarity acquisition
mechanisms are completely different. Whereas the po-
larity of Janus particles is a priori defined by its metal-
lic hemisphere, Quincke rollers acquire polarity by the
spontaneous symmetry breaking of charge distribution on
the particle scale. It could be interesting to investigate
whether this difference in the polarity acquisition mech-
anism alters the global properties of the orientationally
ordered system because the latter might have additional
soft modes on the particle level.

Tracking both the velocity and polarity of all parti-
cles enabled the detailed assessment of the single parti-
cle dynamics both in the disordered and ordered states.

Strikingly, the polarity auto-correlation showed a slow al-
gebraic decay in the polar ordered state, which has never
been studied even numerically. It could be interesting if
this slow decay in polarity could be observed not only in
active colloidal systems but also in collective biological
matter [55].

Our results also suggest the interplay between the po-
larity and velocity of the particles which might be ex-
plained by the hydrodynamic and/or the electrostatic
torques between the particles. We have shown that this
interplay is amplified in the high density ordered state.
This interplay between polarity and velocity is something
that cannot be observed in the polar Vicsek model where
the two vectors are identical and degenerated. A recent
numerical study shows that the global properties could
differ drastically by decoupling the polarity and veloc-
ity of the system [57]. Our polarity resolved realization
of the collective phase of self-propelled Janus particles
can contribute to bridging the understandings on the two
major active matter classes: the Vicsek physics and the
Active Brownian Particles. Overall, our system of Janus
particles provides a large scale statistical study for polar
ordered active colloidal particles, which opens a new av-
enue on further theoretical and experimental works for
the field of active matter.
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SI. SPATIAL FOURIER TRANSFORM OF THE DENSITY FIELD

To investigate the sound modes in the ordered state of Janus particles, we computed the power spectra using the
particle coordinates [30]. The spatial Fourier transform of the density field is defined as,

pq(t) — Z eiq[zj (t) cos O+y; (t) sin 9]’ (Sl)
J

where x;(t), y;(t) are the instantaneous particle coordinates, -, takes an average of all particles and g(cos ¢, sin ) is
the wave vector making an angle 6 with the global order (6). Here, the global order is defined as the mean polarity
of all particles averaged through all frames. The power spectra | pq,w|2 (Fig. were obtained by performing time
Fourier transformations to the two-time autocorrelations of the density fields {p,(t) - p§(t +7))¢. The speed of sound
modes ¢(0) = limg_, [w (€) /q] were obtained from the positions of the peaks in the dispersion relations given by the
power spectra (Fig. . Here, the positions and widths Aw of the peaks as a function of ¢ in the power spectra were
determined by fitting the |p,(w)|® curve using a Lorenztian function, f(z) = W + b, where a,7,zo,b are
vy

fitting parameters.

0=n/2 0 0=3a2 0

(10°0d) /(|7 d))3o]

=z —12n 0 12z Ix =z —12zx 0 12r % =z -1z 0 127 1% =z =112z 0 12r 1z
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FIG. S1.  Full power spectra of the density fluctuations, {|pq.w|*)/{|po,0|?>). The angle of the wave vector 6 is defined with
respect to the global order ().

The 0 dependency of ¢(f) could be fitted by a cosine curve: acos (b 4 ¢) with a = 9.5, b = 1.0, and ¢ = 0.65,
respectively (Fig. a)). The speed of sound ¢(#) is comparable to the mean velocity of the particles in the ordered
state (v, ~ 8.5um/s) which indicates that the observed density fluctuations are caused by the advection of the
particles. In addition, sound modes of particles that move in the same direction with a uniform velocity exhibit a
sinusoidal dependency against 6, which again suggests that the sound modes observed in our system originate from
the advection in the system.

We have also plotted the peak widths Aw, characterized as the full width at half maximum (FWHM) of the fitted
Lorenztian, as a function of g (Fig.[S2|b), (c)). Although the statistical noise in our system kept us from observing
the two mixed sound modes as predicted by Toner and Tu, we were still able to observe the algebraic behaviors
underlying the sound modes. For both longitudinal and transverse directions, Aw(q) showed a slope close to 2 where
3 um < 1/|q| < 7 pm, indicating that the sound modes are subject to diffusive damping. On the other hand, Aw(q)
showed a slope smaller than 2 at length scales larger than typical interparticle lengths 7 um < 1/|q| which suggests the
existence of long-range correlations that suppress diffusive damping. Interestingly, Aw(q) showed similar exponents
for both longitudinal and transverse directions which is consistent with the results of C¢ (R) (Fig.[9), indicating weak
anisotropic correlations with respect to global order. Note, the theoretical predictions given by Toner and Tu are

Aw ~ qﬁ/ 5, q7 (q),L — 0), where z = 1.2, £ = 0.6 are the dynamical and anisotropy exponent, respectively.
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FIG. S2. (a) 0 dependence of the speed of sound ¢(0) = limg—0 [w (0) /g] measured from the slope at ¢ = 0. The blue points
show ¢(0) obtained from the power spectra and the orange solid line shows the fitted cosine curve: acos (b6 + ¢) with a = 9.5,
b=1.0, and 6 = 0.65. (b), (c) Aw(q) characterized as the full width at half maximum of the fitted Lorentzian for the Fourier
transformed density correlation function as functions of g in the longitudinal (b) and transverse (c) direction with respect to
the global order. The black dashed line with a slope: 1.2, 2 is a guide for the eye. The red, blue and yellow areas correspond
to length scales smaller than the particle’s diameter (< 3 pm), length scales larger than the typical interparticle length in the
ordered state (> 7 um), and length scales in between, respectively.

SII. AUTO-CORRELATION FUNCTIONS

The polarity auto-correlation function f,(7) in a log-log plot is shown in Fig. A slow power-law like decay for
7 > 1 s with a slope close to —0.15 can be observed for f,(7) in the ordered state. The auto-correlation function of the
polarity fluctuations from global order fgiobal,c(T) = (AR (t)- ATy (t+7))e, where ARy (t) = (Np — (M) 1 ordered ) ordered s
is shown in Fig. felobal,c(7) shows an oscillation with a period of ~ 20 s while it decays. This is consistent with
the time scale of the time needed for the particles to propel through the ordered area v, x 20 s ~ 170 pm which is
close to the length scale where the order parameter deviates from true long-range order.
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FIG. S3. Polarity auto-correlation functions f,(7)) in the ordered and disordered state (log-log). The same data as in Fig.[5{a)
in a log-log plot is shown.

SITII. POLARITY DETECTION VIA IMAGEJ

In order to obtain the polarity of each particle, we have applied image analysis methods using ImageJ [47]. Here
we give a description of the whole image analysis procedure in order to obtain the orientation which is defined by
the metal hemisphere. The main idea is to binarize the images of Janus particles and obtain the orientation of each
particle by taking the difference of the center of mass (intensity) and the centroid. In Fig. we show how the
processed image will look like when we perform the following procedure on the raw experimental image (Fig. [S5(a)).

1. We first inverted the whole image (Edit>Invert) and subtracted the background using the rolling ball method
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FIG. S4. Auto-correlation of the polarity fluctuations from global order fgiobal,c(7) = (AT, (t) - Any(t+7))¢. Error bars show
the standard error.

(Edit>Invert, Process>Subtract Background). Since the radius of the particle was ~ 11 pixels, we set the rolling
ball radius to 20.0 pixels (Fig. [S5{(b)).

2. We next detected the edges (Process>Find Edges) and binarized the image (Image>Adjust>Threshold). The
thresholding was done by auto thresholding (Fig. [S5(c)).

3. In order to make the particle detection easier and more precise, we dilated the edges (Process>Binary>Dilate)
and filled in the holes of the particle (Process>Binary>Fill Holes).

4. We detected the particles using the “Analyze Particles” program in ImageJ (Analyze>Analyze Particles). In
order to neglect the noise in the image (e.g. small fragments of metal), we only detected particles which were
larger than 400 pixels. By using “Analyze Particles” we obtained the masks of each particle (Fig. [S5[d)).

5. Since the generated masks were slightly larger than the real particles, the images were eroded for four times
(Process>Binary>Erode).

6. Using the image calculator, we multiplied the inverted image of the particles and the eroded mask
(Process>Image Calculator> Multiply, Fig. [S5{e)). ~ The obtained image was thresholded thereafter
(Image>Adjust>Threshold, (f)).

7. We obtained the outlines of the particles (Process>Binary>Outline) and added the outlines with the thresholded
image (Process>Image Calculator>OR, Fig. g)) The center of mass of image intensity was calculated from
this image.

8. By taking the difference of the position vectors of the centroid and the center of mass of image intensity, we could
obtain the orientation of each particle. The coordinates of the centroid and the center of mass were calculated
by ImageJ (Fig.[S5(h)).

SIV. DETAILS OF EXPERIMENTAL PROCEDURES

We used Trackpy [46] for linking trajectories. The instantaneous velocities v of the particles were computed by
taking the difference of the centroid: v(t) = x.,(t+1) — @, (t — 1), where ¢t denotes the frame number and x., () is the
coordinate for the centroid of particle 7 at frame t. We used the instantaneous velocities for all particles for every 100
frames for computing the velocity distribution in Fig. c)(d). For the computation of the auto-correlation function
fu(7), the velocity was exceptionally defined as, v(t) = ., (t+3) — @, (t), in order to reduce noise in the measurements
by using a larger window. It should be noted that, we used the symmetric definition v(t) = x.,(t +1) — @, (¢t — 1) for
the computation of the cross-correlation function g, ,(7) to avoid confusion in the interpretation.

The order parameter in Fig. [2] was computed using the particle polarities detected by ImageJ. The time series of
the total number of particles in the whole field of view and the polar order parameter for the whole view are given in
Fig. [S6

For inferring binary interactions in Fig. [3] the locations of particle pairs within 6 pm and 30 pm distance were
extracted for statistically independent frames which were 25 frames (= 2.5 s) apart.
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FIG. S5. An example of the image analysis procedure using ImageJ. (a) The raw image of Janus particles (397 x 397 pixels,
57um x 57pum). (b) Image of Janus particles after inverting and subtracting the background using the rolling ball method from
the original image. (c¢) The edges detected from the image in (b). (d) Binary masks of the whole particle. (e) Multiplied image
of the inverted image of particles (b) and the masks (d). (f) The thresholded image of (e). (g) The OR operated image of the
outlines of (d) and (f). (h) Red arrows indicate the orientation of each particle from the difference in the coordinates of the

centroid and the center of mass of luminance.
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FIG. S6. Time series for the total number of particles N and the polar order parameter ’(ew)r‘. (a) Time series for the

disordered state. (b) Time series for the ordered state.

SV. MOVIE DESCRIPTION

Supplemental Movie 1: (1_Disordered.mp4)

Janus particles in the orientationally disordered state. The particles were exposed to a 1000 kHz, 16 V,, AC
electric field. The movie shows the first 1800 frames out of the 3600 frames used for binary collision and other
statistical analysis. The resolution is scaled down to 640 x 512 from the original 3000 x 2400 to reduce the file

size. The movie is played at three times the real speed.

Supplemental Movie 2: (2_Disordered_crop.mp4)



15

The same experiment as Supplemental Movie 1 with a cropped view of 562 x 382 pixel view for the 15th — 55th
frames. The original resolution is kept to ensure the visibility of each particle’s polarity. The movie is played
at the real speed.

Supplemental Movie 3: (3_Ordered.mp4)
Janus particles in the orientationally ordered state. The particles were exposed to a 1000 kHz, 16 V,, AC
electric field. The movie shows the first 1800 frames out of the 3180 frames used for statistical analysis. The
resolution is scaled down to 640 x 512 from the original 3000 x 2400 to reduce the file size. The movie is played
at two times the real speed.

Supplemental Movie 4: (4_Ordered_colored.mp4)
Janus particles in the orientationally ordered state with colored by their deviation from global order. The movie
shows the 1500th — 3000th frames out of the 3180 frames used for statistical analysis. The colors show the
polarity deviation for each particle from the global order in radian. The movie is played at four times the real
speed.
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